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Preferential treatment
In the tips section of this column I will be alternating between basics and more advanced topics. 
I have personally seen designers and artworkers with many years of experience overlooking 
some rudimentary aspects of XPress, so hopefully there will be something useful for everyone. I 
will be using XPress 4 as my reference, but everything should apply to XPress 3.3 unless stated.

Having a proper method of working in XPress makes your daily work routine just that little bit 
easier and quicker. This includes using templates and style sheets, but we’ll start at the beginning
with preferences. 

Preferences are just that, a preferred way of working. Each document can have its own 
preferences, but starting with a clean default set is always a good place to begin, overriding those
set by Quark. When working in a studio situation it is always advisable that everbody has the 
same preferences so as to avoid problems like reflow from different hyphenation settings. Of 
course the later versions of XPress avoid this by offering the choice of maintaining the document
preferences or using those set for the program on that machine.

To set up the preferences you need to have XPress running with no documents open. Most 
commands can be found under the Edit > Preferences menu. The preferences outlined here are 
the ones I generally use and find to work best in most situations. First we should set Application 
prefs. These can be changed at any time without affecting an open document. Under the display 
tab we have first ‘Guide colours’; these are really down to personal taste and have little or no 
effect on performance. 

Below this is ‘Display’. Firstly ‘Tile to Multiple Monitors’ only needs checking if you are 
running more than one monitor, (although with the proliferation of palettes and the low cost of 
small monitors and video cards this can certainly improve the way you work). 

Next, the ‘Full screen Documents’ I leave unchecked. By doing this the document window sits 
inside the Toolbox and Measurement palettes, so that you are not constantly shifting them to see 
your work, the rulers and the scroll bars. 



The following, ‘Off screen redraw’, can be checked to speed things along. Below this are pop-up 
boxes offering a choice of resolutions for TIFF display. Choosing 8 bit for colour will redraw 
quicker and also make smaller files. If you really need sharp on-screen display save your image 
files as EPS with JPEG preview, but not JPEG encoding. Grey can be set to 256 levels.

Next tab is ‘Interactive’. Here, go for speed. If you’ve got a fast machine – use it. If you haven’t 
– you’ll need it. 

Smart quotes should be checked; seeings as how we are supposed to be metric there’s not much 
use for feet and inches these days. However attention should be paid when using inches as there 
are lots of adverts incorrectly set without apostrophes. The easiest way around this is to use the 
‘control’ key to temporarily change the ‘smart quotes’ back to feet and inches. Drag and drop text
can be quite helpful when editing text but be careful when selecting text that you do not move it 
by accident.

The ‘Save’ tab is really useful. It not only saves your documents but could even save your bacon.
Auto save does exactly that – saves your document at a specified interval. It’s so easy to forget to
save regularly when you’re involved in a project. It can slow you down if it is set to save too 
regularly, especially on big documents, but it sure beats redoing a job. 

Auto-backup is really useful if you work to a server as it will keep a remote copy of the XPress 
file. It can even be set to retain a specified number of revisions. If the client decides that it did 
actually prefer your previous layout it will be saved on your disk. Using the belts and braces 
approach is good practice even though it will slow you down. However the choice is yours. 
‘Auto Library Save’ is best checked – it’s just one less thing to think about if you do use 
libraries. Finally the XTension Manager: choose the ‘When’ options, it will speed up the opening
of XPress.

 

he next set of preferences definitely needs no document open to set them as your default, 
although they can be customised for each document when necessary. To access these preferences 
use either -Y, the mouse and menu Edit>Preferences>Document or double-click on any tool on
the tool bar to take you straight to that tool. 

Under the ‘General’ tab is where the measurements and other page attributes are set. Most people
nowadays seem to work in millimetres (apart from Americans). 

Auto Page Insertion is probably best set to ‘End of Story’ so that if extra text is inserted you can 
find it in a logical place. 



Framing, inside or outside, is really down to personal choice or document. It would be nice if it 
could be specified at an individual level, maybe next version. 

Guides are best set ‘In Front’, basically so they can be seen! ‘Item Coordinates’ can be left to 
page.

‘Auto Picture Import’ is best set to ‘On (Verify)’, that way you know if any pictures are missing 
or modified but have some control over how they are updated. 

‘Master Page Changes’ can be set to ‘Keep Changes’. 

On the right hand side of the tab are further settings, these can be left at the default. ‘Greek 
Pictures’ is nothing to do with paintings of athletic men or holiday snaps of Aegean Isles, but it 
allows picture previews to be switched off to speed up screen redraw. (See review of XPert Tools
for an alternative).

The next tab, ‘Paragraph’ can be left as default. This really is something that can be set at 
document level, particularly the ‘Baseline Grid’. If you are working on a single publication that 
utilises this feature it can be set to your default, but it is probably better to set it at a template 
level. (Templates will be covered in a future article).

 

he next tab is for ‘Character’ preferences. These are more or less a workaround for achieving 
certain typographic effects when there are no ‘Expert Sets’ of particular fonts. They are also 
down to typographic taste and basic rules. 

‘Superscript’ I would set to between 50% and 70% on the VScale and HScale, depending on the 
typeface used, with the offset adjusted accordingly. If you have not installed the ‘Type Tricks’ 
XTension from Quark then the following settings will allow you to easily set fractions. Set the 
‘Subscript’ offset to 0% and the HScale and VScale to 50% to match the settings for ‘Superior’. 
You may wish to increase this to 55% or 60%, again depending on the character, or even increase
the HScale by a few percent. Use ‘Superior’ for the numerator and ‘Subscript’ for the 
denominator. 



‘Small Caps’ will always look better if they come from a proper font. They are weightier, to 
match the Caps, rather than just scaled-down versions. You can fake this a little by setting the 
HScale to, say, 5% more than the VScale. Real small caps generally tend to be to the x-height of 
the character, so while the default of 75% is fine it may need to be adjusted at document level 
depending on the typeface chosen. 

Ligatures is probably better left unchecked. This works in a similar way to ‘Smart Quotes’ in that
it automatically substitutes a keyboard character for another. Ligatures are best kept to serif faces
and especially for headlines and type over 12 point. You can always use the Find/Change to 
substitute with greater control. Most standard character sets carry fi (alt-shift 5) and fl (alt-shift 
6). ‘Accents for All Caps’ is again a document level choice. For example, French doesn’t require 
them but Italian usually does. If you are doing European language setting it is advisable to know 
something about the language, or use XPress Passport which will give proper hyphenation as 
well.

Next we come to the ‘Tools’. In XPress 4 there is a greater variety of tools available but luckily 
they have created an option to ‘Select Similar’ so that when you set up one it sets the same 
preferences for them all. So if we start with a text box and click ‘Select Similar Types’, then 
‘Modify,’ these changes will apply to all text boxes. There are only a few things that need to be 
changed to defaults, i.e. under the ‘Box’ tab set colour to ‘None’; under the ‘Text’ tab set ‘Gutter 
Width’ to 5mm and most importantly ‘Text Inset’ to 0 (zero) and finally under the ‘Runaround’ 
set this to ‘None’, on those rare occasions you need runaround on a text box you can set them at 
an individual level.

 Now run through the picture box options. Here the important thing is to ensure that your picture 
boxes have a white fill to stop ‘jaggies’ with TIFF files. Setting your rule prefs is again a matter 
of personal taste. It is advisable not to use a line width of less than .25pt as it can give problems 
at repro.

I’ll not go through Colour Management this time as it is a subject unto itself.

 

ther preferences that can be set are for ‘Style Sheets’ (which I will cover in detail on another 
occasion), ‘H&Js’ and ‘Colours’. The default ‘Style Sheet’, ‘Normal’ is basically Helvetica 12pt. 
and can be left as that. 

Under ‘Colours’ it is advisable to remove the colours Red, Blue and Green as they are RGB 
colours and will cause problems when printing to a CMYK colour printer. 



The default for ‘H&Js’ (Hyphenation & Justification) is called ‘Standard’ and offers automatic 
hyphenation. Ideally you need two defaults; one which hyphenates and one which doesn’t. You 
have to choose whether to have hyphenation turned on or off as ‘Standard’. Personally I would 
opt for ‘Off’, then create a new one called ‘Hyphenation’ using the parameters shown below. 
Tradition dictates that there should be no more than three successive hyphens. The spacing 
options are dictated by individual fonts and taste, but there has to be a starting point.

Here endeth the lesson. Best thing to do now is quit out of XPress to ensure that all these 
preferences are saved, because if you crash or ‘Application unexpectedly quits’ then you could 
be back to square one. I know this is not a particularly riveting or entertaining piece, but most 
people don’t take the time to set their preferences and enjoy the benefits. 

XPert Tools
Last time (1984 Online no 8) we looked at Extensis QX-Tools 4, so this time we’ll see how the 
other main suite of XTensions have faired in the upgrade to XPress 4.

Apart from introducing a Windows version and an installer that covers either versions 3.3 or 4, A
Lowly Apprentice Productions (alap) have not modified their two part suite of XPert Tools to 
compensate for the new features in XPress 4. For those who have still not made the upgrade to 
XPress 4 these tools are a must have. In fact if you couple them with Markztools III from 
Markzware, there is really not a lot of reason to upgrade. I know of lots of repro houses which 
almost exclusively output from 3.3 as it is far more stable and compatible with their RIPs.

I will review each set independently showing what is now redundant with XPress 4 and how it 
compares with QX-Tools, which will hopefully help to guide you in your buying decision. 

Volume 1
To start with I will briefly cover the functions of those XTensions which I personally consider 
not particularly enhancing, and can therefore be skipped at the installation.

XPert Loader™ was essential for 3.3 as it allowed management of all the XTensions loading in 
XPress. This is, of course, obsolete with the introduction of XTension Manager in 4, although it 
does give you a hot key that allows you to open it before XPress starts to load the XTensions if 
you have a last minute change of mind. Not for 4.

XPert Open™ will save you a mouse click for each document you open if you work with a lot of 
documents from external sources or if your studio does not have a uniform set of preferences 
(see Preferential Treatment). It merely gives you the opportunity to open a document 
automatically with either the Document settings, the Application’s settings or asking when 
opening document. If you're going to chose the last option then you don’t need to use up memory
with this XTension.

XPert Quit™ ‘lets you control when QuarkXPress automatically quits’, says their manual. If it 
lets you control when it ‘unexpectedly quit’ then it would be useful.

XPert Launch™ works like Apple’s Launcher but from within XPress. I’m not sure how it is 



really going to improve your workflow dramatically.    

XPert Menus™ is another to fall by the wayside in the march of progress. Again, essential for 
XPress 3.3, it added four pop-up icons at the bottom left hand corner of a document allowing 
magnification up to 1200% (in 4 it will only go to 800%), access to (go to) pages, access to tools 
and access to other open documents (which can be done by shift clicking on the title bar). Not for
4.

XPert View™ allows you to create customised layouts for multiple documents. Why you would 
want to have four documents open in four equal sized windows is a little beyond me. 
Occasionally there is a need to compare files but not so often that you need an XTension to do 
your layout for you. You would need at least a 21" monitor, and a second one if you load all the 
XPert Tools.

The next two are a little more useful, although I’m not 100% convinced.
XPert Ungroup™ will ungroup all items in a group. This is more extreme than your usual 
ungroup as it affects all groups with a group. A little drastic and probably something you would 
want a little more control over. It may save a little time but you’d want to be sure of what you’re 
doing.

XPert Paste™ allows an item to be pasted into the same position on another page. Could be 
useful on occasions. Well planned master pages are a better idea.
Now come the really useful ones: 

XPert Textlock™ is a handy security feature if you have a habit of accidently deleting or editing 
text that you shouldn’t. Where XPress’s ‘Lock’    makes the item immovable, Textlock makes the 
text within a box ineditable. Unfortunately it affects the whole box and not just the highlighted 
text.

XPert Nudge™ adds a tiny floating palette, which fits nicely next to the Measurements palette, 
that allows you to specify the distance you can move items with the arrow keys. There is a list of 
presets, in points, or you can enter any amount you like in mm, cm, " (inches), etc.

XPert Print™ allows you to print or make an EPS of a section of a page. It can be done in two 
ways; either with the XPert Print tool and selecting the area or from the ‘File’ menu and 
specifying the co-ordinates. Really handy if you need to fax just a small section of a large job to 
a client for approval of copy corrections.

XPert Color™ gives you the ability to do find/change to colours with the option of choosing 
either Boxes, Text, Frames, Pictures, Lines or Blends or any combination thereof, even tints. 
While you can do a blanket colour change in XPress already by deleting a colour and replacing it
with another in the colour palette, this is less drastic and much better controlled. XPert Color also
lets you change colours between spot and process, but this is already built into XPress 4. Does 
not have the depth of features that Extensis QX-FindChange has.

 



Pert ImageInfo™ is a very clever and useful XTension if you use lots of pictures in your 
documents and like to keep an eye on them. In the top left hand corner of each picture box it 
adds a small triangle which, when clicked, gives a pop-up palette full of all the information about
the image you could possibly need. It is smart enough to even present different options 
depending on image type (TIFF, bitmap EPS, vector EPS etc.). It can even print out a detailed 
breakdown of all the images in the document, which can serve as a handy pre-flight check. It will
flag some possible problems, though not as well as dedicated programs do, but anyone with a fair
knowledge of repro will not need much more information.

XPert Scale™ offers a solid alternative to Quark’s somewhat weak scaling capabilities. Feature 
for feature it matches QX-Tools, although the QX-Tools version does give you the extra option 
of specifying either a height or width measurement, whereas XPert Scale offers only width.

 

Pert Layers™ adds that much-needed feature to XPress. Although not as intuitive as its QX-
Tools counterpart - the icons are a little confusing but there is a menu driven alternative - it 
works equally well once you are familiar with its idiosyncracies.

Volume 2
The first victim of this suite was XPert CharacterStyles™. It went from star to has been 
overnight. As did XPert BoxTools™, which allowed picture boxes to become text boxes, and 
vice versa, although this did have another trick of creating different insets on the four sides of a 
text box. The rest of the suite seems to have survived quite well; their usefulness, however, is 
down to personal choice.

You can customise the interface with XPert Preferences™ and also with XPert CommandPad™. 
I find all those little icons, like in Microsoft Word, a little annoying and I am so used to using 
keyboard shortcuts it seemed a little counter-productive. 

The same with XPert Pilot™. It is a great idea, similar to the Navigator palette in Adobe 
Photoshop, which even allows you to mark positions in a document that can be returned to with a
mouse click, but those who have been working with XPress for some time may find it more of a 
hindrance than a help. 

Also with XPert Rulers™, it adds a clever tool for showing measurements on boxes but you still 
can’t beat the measurements palette for accuracy and precise positioning.



 

Pert PageSets™ are a type of style sheet for document set-up. It gives an enhanced set of savable
options for creating new documents. If you do use a fixed range of set-ups it is probably better to
use properly formatted templates, which can also include everything from colours to style sheets.

Now we come to the XTensions that can help improve your productivity. XPert Scripter™ adds a
palette that can give you access to AppleScripts (a selection is included on the disk). With the 
improvement to AppleScript in MacOS 8.5 this becomes a really powerful productivity tool (if 
you understand scripting).

 

Press has never been strong at tables, but with XPert TexLink™ and XPert TextStyler™ and the 
improved tabulation in 4 the capabilites are expanded. TextLink gives a palette of different ways 
of linking and unlinking text boxes. Better still is TextStyler, which when used in conjunction 
with paragraph and character style sheets makes easy work of simple tables. Basically TextStyler
lets you marquee say, a column of text and change its attributes, even using character style 
sheets. Much quicker than amending line by line.

The measurements palette offers a wealth of information about the typography in a box. XPert 
TextScale/Shift™ adds a small palette with another two vital, and easily forgotten, specs: 
baseline shift and horizontal/vertical scale. These attributes are fully editable, giving easier, more
precise control than can be achieved by keyboard shortcuts.

If you work on visually rich documents, filled with high-res pics, and get frustrated waiting for 
them to redraw then XPert Greeking™ is a great alternative to XPress’s all or nothing picture 
greeking. Individual picture greeking can be switched on or off from the menus or, if you chose 



to use the CommandPad, with a mouse click.

A lot of designers/artworkers, particularly in advertising, like to set-up their documents within a 
larger page and add their own cropmarks, media etc. I’ve never fully understood the advantage of
this, but everyone has their own madness in their methods. For those who like to work in this 
way XPert ItemMarks™ is the perfect solution. This XTension allows the user to assign 
cropmarks, registration marks and colour scales on any item on a page. It is a sort of scaled down
version of ALAP’s Markit XTension, which is usually used in conjunction with Imposer, ALAP’s
imposition XTension.

The final XTension in this suite is XPert JobLog™ which keeps a record of who, when, where 
and which machine worked on a job. It even shows how long the document was opened for. 
Great for billing purposes, but if you work in a studio, remember to close the document before 
going to lunch or the boss may wonder why you’ve taken so long to correct two literals.

Last word
Two years ago XPress 3.3 with these two volumes of XPert Tools was publishing heaven and it 
is still a formidable combination today. There are now, however, alternatives. XPress 4 has 
devalued these suites, and QX-Tools, especially version 2, offers excellent value for money. QX-
Tools 4 does have the advantage of offering dockable palettes that save on valuable screen space.
If you were to run even only the best of XPert Tools you would need plenty of monitor area, 
preferably a second monitor. 

If ALAP updated the stronger tools in both volumes and combined them into one set, they would 
be back on top with a winner. With Quark saying they are aiming to release XPress 5 next year, 
maybe they are just biding their time so as not to be caught out with another set of redundant 
tools.

If you do decide that you need these XTensions, be warned that you may experience problems if 
you are running MacOS 8.5. ALAP have posted an updater, that patches all their XTensions, on 
their web site (www.alap.com).    I tested all these on my 8500/160 with 40Mb allocated to 
XPress 4.04 using 8.5 and was constantly restarting. I have used them with earlier system 
versions in XPress 3.3 and I found them very stable and a pleasure to use. You have been 
warned.

X rating:
XXX (XPress 4) 

XXXX (XPress 3.3)

Updaters
If you haven’t already done so, download the latest updater to 4.04 from the Quark website. It 
resolves lots of bugs. There are two versions, a small one to upgrade from 4.03 and a much larger
one to update from earlier versions.

If you are one of the pioneering types and have updated to 8.5 you may have noticed some 



problems with fonts (amongst other things). There seems to some incompatability between 8.5, 
XPress 4.04 and Adobe ATM 4 Deluxe, with Adobe Type Reunion Deluxe also thrown into the 
equation. If you load fonts using ATM while XPress is open, some fonts will become greyed out. 
They render on screen but are inaccessible. If you quit out of XPress and re-open the document 
everything is as it should. It's not a life threatening situation, but it is annoying and a little 
retrograde. At the time of writing neither Apple, Adobe nor Quark were able to offer any 
solutions.

More Freebies
Go to http://www.meadowsinfo.com and you can download the Font Collector XTension that 
will collect all the fonts in an XPress file, including those imbedded in EPS files. It is not 
compatible with XPress 4 but they are promising an update in the new year.

At http://www.badiasoftware.com you can download FullMeasure XT, a very handy little 
XTension that extends the Measurements palette to include the attributes: horizontal/vertical 
scale, baseline shift, type colour, first line indent, left indent, right indent, space before and space
after. These can be edited in the same way as any other Measurements field. It does have certain 
minimum requirements, being: XPress 4.03 and a 17" monitor. It is compatible with MacOS 8.5.

All screen grabs in this column were made with the shareware Snapz Pro from Ambrosia 
Software <http://www.AmbrosiaSW.com>
Chris Patmore
<chrispatmore@innocent.com>
 
 


